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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in August 2025

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Index Name
HS Mainland
-4.39
Banks Index ~4-3% CSI 300 Index +10.3%
HSI I +1.2%
i FTSE A50 Index +8.5%
HSCEI I +0.7%
CES120 Indes - L45%
MSCI China A 50 Index +13.7%
% Change

Equity Index Futures Access Codes
Vendor HS Mainland Banks CES 120 HSI HSCEI
Bloomberg BMWA CESA HIA HCA
Refinitiv 0#HMBI: 0#HCHH: O0#HSI: O#HCEL:
WIND MBIF CHHF HSIF HHIF
ET Net MBI CHH HSI HHI

Data Source: Bloomberg
As at 29 August 2025

Information for reference only
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Equity Index Futures & Options
Hang Seng Index (HSI) Futures & Options

HSI Products - HSI Futures (YoY) HSI Options (YoY)
(2025 vs 2024)

A’\Yer?%e Et>aily Volume Open Interest Av erage Daily Volume Open Interest
(No. of Contracts) (No. of Contracts) (No. of Contracts) (No. of Contracts)
. . 280,000 | ADV (L-Axis) r 200,000 60,000 - ADV (L-Axis) 4
HSI Futures 128,797 (-8%) 141,766 (+18%) 240,000 | = Open Interest (R-Axis) Open Interest (R-Axis)
200,000 - - 150,000 45,000 - - 300,000
160,000 ’\N
. - 100,000 30,000 - - 200,000
Mini-HSI Futures 96,758 (+0%) 17,467 (+25%) 120,000 -
80,000 ~ - 50,000 15,000 - - 100,000
40,000 -
0 - -0 0 +-—————++—+-+0
HSI Options 15,199 (-23%) 66,033 (-5%) D0 X NP B 5 0 A O N D&
S S S S S S S S S S

Mini-HSI Options 13,510 (-23%) 37,996 (+99%)

Av erage Daily Volume Open Interest Z’\’\}/oe(r)?%eorlil)ra;ﬂ%ls)Volume ('\? pefn CI ntte rets ;
. 0. Ol ontracts
(No. of,Contrat_:ts) ADV (L-Axis) (Nti- of COf:tFﬁCtS) 0 - ADV (L-Axis) - 150,000
HS! Fut Open Interest (R-Axis) s Ope 1 Interest (R-AXis)
utures o 0 ] l I
Options 2,653 (-41%) 42,716 (-13%) 150,000 I l I 150,000 20,000 - 100,000
(]
100,000 - - 100,000
. 10,000 - - 50,000
HSI Volatility 00) 0() 50,000 - L 50,000
Index Futures
0 i | 0 0 Q. > 0 > 0
T c s s c=s O
HSI Dividend 385888828533
Point Index 26 (-53%) 3,181 (+101%) s | o005 o024 | 2025
Futures

Data Source: HKEX
* Ol compared to previous year-end
Information for reference only

As at 29 August 2025
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level HSI & Top 5 Constituents

Index Description I.nclludes the I.arges.t and most ('000) -
liquid stocks listed in Hong Kong 27 - hs S| - 29 - HSI Index Tencent
Index Level 25,077.62 (As at 29 Aug 2025) HSBC — BABA
26 - " 2T 430 | Xiaomi Meituan
Index Volatility (30-Day Historical) | 26.7
25 - 25
Index Avg. Day High-Low Range 239.58 (Aug 2025) 110 - p
HSCH Correlation (2025) 0.992 241 23
90 -
23 - 21
Hang Seng Index Futures 22 . . 19 70
Jun-25 Jul-25 Aug-25 Jun-25 Jul-25 Aug-25
Contract Multiplier HK$50
Notional Value (1 Contract) HK$1.25Mn (As at 29 Aug 2025) Distribution of HSI Index Options Ol in Month-end
Call Put
Transaction Cost*
=)
= S
Stam p Duty N/A S 310 £ 31,0
~— . 8
Trading Fee HK$10 / contract b5t i
T .40 2 240
SFC Levy HK$0.54 / contract £ =
2 5
Commission Rate Negotiable % 17.0 © 17.0
© £
<
Margin as of 27 Aug 2025 HK$107,900
10.0 | i . . 10.0 | . ,
0 1 2 3 0 1 2
Open Interest ('000) Open Interest (‘000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference only

As at 29 August 2025
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Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Futures (YoY

HSCEI Products ADV ( )
(2025 vs 2024) Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)

240,000 - == ADV (L-Axis) - 700,000
5 e Open Interest (R-Axis) | 600.000
HSCEI Futures 154,737 (-18%) 260,628 (2%) 200000 ’
160,000 - 500,000
- 400,000
120,000
o - 300,000
utures 40,000 - - 100,000
0 - -0
5 O A 9 N D&
O QS S
HSCEI Options 17,141 (44%) 275,711 (+0%) vY v e e e
HSCEI Futures (MoM)

.. Av erage Daily Volume Open Interest
Mln-l HSCEI 3’001 (_25%) 30,842 (+1 14%) (No. of Contracts) (No. of Contracts)
Options 275,000 - ADV (L-AXis) - 600,000

Open Interest (R-Axis)
220,000 -
HSCEI Futures 50 o1 (12%) 703,595 (+12%) 165000 || I [ 400,000
Options |, I i
i
110,000 -
- 200,000
HSCEI Dividend 55,000 -
Point Index 458 (-63%) 36,574 (+40%)
Futures U C — a0
§85888528533
2024 2025

Data Source: HKEX
* Ol compared to previous year-end
Information for reference only

As at 29 August 2025

X

HSCEI Options (YoY)
Av erage Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)
120,000 - ADV (L-Axis) - 2,800,000
100,000 - Open Interest (R-Axis) | 2,400,000
80,000 - - 2,000,000
- 1,600,000
60,000 H
- 1,200,000
40,000 4 - 800,000
20,000 - - 400,000
0 T T T LN B B B O
2 o A O P DB
NN

Av erage Daily Volume
(No. of Contracts)

50,000 -
40,000 -
30,000 -
20,000 -

10,000 -

0

ADV (L-Axis)

e Open Interest (R-Axis)

HSCEI Options (MoM)

Open Interest
(No. of Contracts)

- 600,000

- 400,000

- 200,000

QG 2 9c S5 >
5828582288
2024 2025

Jun

Jul
Aug




Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI HSCEI & Top 5 Constituents

i he |
Index Description Comprlse.st e largest and 1
most liquid H shares 09 , 150 -
e HS| e=——HSCEI e HSCE Xiaomi
Index Level 8,947.79 (As at 29 Aug 2025) 107 - —— Tencent —— BABA
CCB Meituan
Index Volatility (30-Day Historical) | 28.9 105 - 130 1 A
Index Avg. Day High-Low Range 91.59 (Aug 2025) 103 - 110 - o ;
Correlation with HSI, CES120 (2025)| 0.992,0.97 101 -
90 -
Correlation with CSI300, FTSE A50 99 -
0.764,0.733
(2025)
97 T T r . 70
1-Aug  8-Aug 15-Aug 22-Aug 29-Auc Jun-25 Jul-25 Aug-25
HSCEI Futures
Contract Multiplier HK$50 Distribution of HSCEI Index Options Ol in Month-end
Notional Value (1 Contract) HK$0.45Mn (As at 29 Aug 2025) Call Put
15.0 15.0
o
] S 13.0 g13.0
Transaction Cost* 8 -~
= 11.0 8110
Stamp Dut NA g &
PR & 90 290 |m—
o =
Trading Fee HK$3.5 / contract = 70 ‘2 7.0
7] @
T
SFC Levy HK$0.54 / contract 3 50 £50
£
Commission Rate Negotiable L — 3.0 ) . . )
0246 810121416182022 0 4 8 12
Margin as of 27 Aug 2025 HK$42,200 Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference only

As at 29 August 2025
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Weekly HSI & HSCEI Options Performance

Contract Multiplier

Liquidity Providers

HK$50

ABN, BNP, Citadel, Eclipse, IMC, Optiver,
Susquehanna, Yue Kun

Transaction Cost*

Stamp Duty
Trading Fee

SFC Levy
Commission Rate

N/A

HK$10 / contract
HK$0.54 / contract
Negotiable

Weekly HSCEI Options

Contract Multiplier

Liquidity Providers

HK$50

ABN, Citadel, Eclipse, IMC, Optiver,
Susquehanna

Transaction Cost*

Stamp Duty
Trading Fee

SFC Levy
Commission Rate

Contract Multiplier
Liquidity Providers

Stamp Duty
Trading Fee

SFC Levy
Commission Rate
ATrading fee discount at HK$2.5,

X

Data Source: HKEX

Information for reference

N/A

HK$3.5 / contract
HK$0.54 / contract
Negotiable

HK$50
ABN, Eclipse, IMC, Optiver, Susquehanna

N/A

HK$5 / contract”
HK$0.54 / contract
Negotiable

until further notice

Weekly HSI & HSCEI Options Volume

Volume

(No. of Contracts)

30,000

25,000 -

20,000
15,000
10,000

5,000 -
0 -

1/8

4/8

Volume

5/8
6/8

(No. of Contracts)

15,000 -

10,000 -

5,000 -

m Weekly HSI Options
m Weekly HSCEI Options
m Weekly HSTECH Options

7/8

8/8
11/8
12/8
13/8
14/8
15/8
18/8
19/8
20/8
21/8
22/8
25/8
26/8
27/8
28/8
29/8

—\Neekly HS| & HSCEI &HSTECH Options Call
—\Neekly HS| & HSCEI & HSTECH Options Put

1/8

4/8

5/8
6/8
7/8
8/8
11/8
12/8
13/8
14/8

15/8
18/8
19/8
20/8
21/8
22/8
25/8
26/8
27/8
28/8
29/8

An investment tool to manage short term event risk

* All calculations are in HKD and exclude commission fees

only

As at 29 August 2025



Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2025 vs 2024) _“ No. of Single Stock Derivatives

Stock Futures 8,550 (+2%) 35,774 (+45%) Single Stock Futures
Stock Options (Monthly and Weekly) 863,627 (+20%) 17,090,869 (+56%) Single Stock Options 132
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Avera% Daily Volume Open Interest  Average Daily Volume Open Interest
No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
10.000 - Open Interest (R-Axis) Open Interest (R-Axis)/., - 16,000,000
’ ’ - 30,000 800.000 7 - 14,000,000
8,000 - r 600.000 - - 12,000,000 * Products
6.000 - . 20000 ’ - ;068800,880 > 3 A-shares ETFs futures contracts
4,000 1 400,000 - - 6,000,000 > Total 97 stock futures contracts
- 10,000 200,000 - - 4,000,000
2,000 1 - 2,000,000
0 - | 0 0 T rrr rr 11 111 0
« O A O N D&
NI S I D, S QP K Q¥ B P g
S S B S S PP PP P PP
Stock Futures (MoM) Stock Options (MoM) Stock Options
Av erage Daily Volume Open Interest Average Daily Volume Open Interest * Products .
(No. of Contracts) (No. of Contracts) (No. of Contracts) ( ) (No. of Contracts) » 3 A-shares ETFs options contracts
. e ADV (L-Axis) i 1,400,000 - ADV (L-Axis - 20,000,000 i
12,888 _ Operdntercat (R-Axis) | 90:000 1400, Open nterest (R-Axis) [ 20" > Total 132 stock options pont:acts (10 of
’ 1,200,000 - . 16.000.000 them are weekly stock options*)
14,000 - - 40,000 ,000,
12,000 1 1,000,000 -
10,000 - - 30,000 800,000 - 12000000 . Market Makers (MMs)
8,000 1 - 20,000 600,000 - - 8,000,000 > 3 types of market makers (PMM/ CQMM/
6,000 - 400,000 - QRMM)
4,000 - 10,000 5090000 - - 4,000,000 ) ) ;
2,000 ’ o 0 » CQMM to provide 50 series continuous
0 0 - C o= uotations
Q_5>QC_8§!5_>,CEU %osgc-smo.(%‘cjc q
$0z288L=<23°2 B0z SUL=<=3"2 A Alibaba Group, Baidu, BYD, HKEX, HSBC, JD.com,
2024 | 2025 2024 | 2025 Kuaishou, Meituan, Ping An, Tencent

Data Source: HKEX
* Ol compared to previous year-end
Information for reference only

As at 29 August 2025
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Hang Seng TECH Index Futures, Options and Futures Options Performance

Hang Seng TECH Index Open Interest (as of 29 August 2025)

Tracks the largest technology companies
Index Description
listed in Hong Kong Open Interest
(No. of Contracts)
400,000 -
Hang Seng TECH Index Futures & Options & Futures Options
Contract Multiplier HK$50 per index point 350,000 -
Notional Value (1 Contract) HK$284K (As at 29 August 2025) 300.000 -
No. of Liquidity Providers N/A
250,000 -
Transaction Cost* 200.000
Stamp Duty NA 2 8 3 8/ 8 8 &8 § § 3 9
) < -
Trading Fee HK$2.50 / contract » z 0 | cow 2 = 7 < |
SFC Levy HK$0.54 / contract 2024 2025
Average Daily Volume (as of August 2025)
ADV
(No. of Contracts)
250,000 -
200,000 -
150,000 -
100,000 -
50,000 -
0 -

2024 2025

Providing investors with a tool to manage their risk exposure .
. . Volume and Open Interest continue to growth
to Hong Kong-listed technology companies

Data Source: HKEX
* Exclude commission fees, the Exchange is offering market-wide 50% trading fee discount of HK$2.50 per contract ( the standard trading fee is HK$5.0 per contract)
Information for reference only

As at 29 August 2025

X "



MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Average Daily Volume (as of August 2025)

o Balanced representation from 11 sectors
Index Description )
of top 50 China A shares ADV
Index Level 2,505.23 (As at 29 August 2025) (No. of Contracts)
25,000 -
Index Volatility (30-Day Historical) | 16.3 20.000
Index Avg. Day High-Low Range 28.84 (August 2025) 15,000
CSI300 Correlation (2025) 0.964 10,000
FTSE A50 Correlation (2025) 0.97 5,000
0
MSCI China A 50 Connect Index Futures
Contract Multiplier Us$25 2024 | 2025 |
Notional Value (1 Contract) US$0.06Mn (As at 29 August 2025) Open Interest (as of 29 August 2025)
Average Quote Size US$0.31Mn (5 Contracts)
Open Interest
(No. of Contracts)
19,000 -
Transaction Cost*
Stamp Duty N/A 15,000 -
Trading Fee US$0.5 / contract
11,000 -
SFC Levy US$0.07 / contract
Margin as of 27 Aug 2025 US$3,450 7,000 - C _
& 8 3 3/§ 8 &8 &8 & 5 3 9
wn O z Aa|l> 0o = < s 5 7 Z
2024 | 2025 |
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX
* All calculations are in USD and exclude commission fees, the Exchange is offering market-wide 50% trading fee discount of US$0.5 per contract (the standard trading fee is US$1.0 per contract)
Information for reference only

As at 29 August 2025

X



MSCI Asia and Emerging Market Index Futures Performance

MSCI Asia and Emerging Market Index

Index Description

MSCI Asia and Emerging Market Index Futures

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*
Stam p Duty

Trading Fee

SFC Levy

representation 38 DM and EM countries and

regional indices

Average US$40
Average US$61K (As at 29 August 2025)
12

NA
US$0.6-US$1.0 / contract
US$0.07 / contract

HKEX with the broadest suite of MSCI derivatives products
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference only

As at 29 August 2025

X

Open Interest (As of 29 August 2025)

Open Interest
(No. of Contracts)

160,000 -
140,000 -
120,000 -
100,000 -
80,000

60,000

Average Daily Volume (As of August 2025)

ADV

(No. of Contracts)

40,000 -
30,000 -
20,000 -
10,000 -

0 -

5 2 9/ 2 5§ 5 > c 5 ©
©c 2z 43S ¢ =<2 3> 2
2024 | 2025 |

2024 2025

Volume and Open Interest continue to growth

12



MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Open Interest (29 August 2025)

e representation 2. DM cour.1tr|es (excl. Japan) Open Interest
and 9 EM countries in Asia (No. of Contracts)
Index Level 686.70 (As at 29 August 2025) 18,000 -
Index Volatility (30-Day Historical) | 13.6 12.000 -
Index Avg. Day High-Low Range 5.28 (August 2025)
6,000 -
HSI Correlation (2025) 0.855
HSCH Correlation (2025) 0.825 0 0 = - o c o o = - c = o
B 0 T o @ =
80203332{23_’2
MSCI AxJ Futures 2024 | 2025 |

Contract Multiplier
Notional Value (1 Contract)

Avg. Quote Size

US$100
US$69K (As at 29 August 2025)

US$0.34Mn (5 Contracts)

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

Avg. Bid-Ask Trading Spread 1.5 index points (August 2025) 140 - mgg: g‘éj mgg: Icr:]r:jiiga _____________ mgg: :-rlsonesia
Lo T T RS MSCI Korea ~ -oeveeeeees MSCI Malaysia MSCI Pakistan
Sasieitiionicers Al @l 17 226 130 | = MSCI Philippines - MSCI Taiwan MSCI Thailand
120
Transaction Cost*
Stamp Duty NA 110
Trading Fee US$0.5 / contract 100
SFC Levy US$0.07 / contract
90 T :
Margin as of 27 Aug 2025 US$2,580 Jun-2025 Jul-2025 Aug-2025

MSCI AxJ is a well-established benchmark representing Asia

Futures contracts have relatively lower transaction costs . . .
regional (excluding Japan) equity market performance

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference only

As at 29 August 2025

X



Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI) 5-Min Avg. Bid-Ask Spreads (29 August 2025)

Index Description 10 largest and most representative
: HKEX-listed mainland banks stocks HSMBI Futures
CEB Bank 6818.HK 0.45%
Index Level 3,787.19 (As at 29 August 2025)
PSBC 1658.HK
Index Volatility (30-Day Historical) | 17.0 Minsheng Bank 1988.HK
Index Avg. Day High-Low Range | 43.29 (August 2025) Bank of China 3988.HK
Bankcomm 3328.HK
HSCH Correlation (2025) 0.765 ICBC 1398.HK
ABC 1288.HK
CM Bank 3968.HK
Hang Seng Mainland Banks Index Futures CCB 939.HK
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.19Mn (As at 29 August 2025)
Avg. Quote Size HK$0.95Mn (5 Contracts) Index & Constituents 3-Month Performance (Rebased to 100)
Avg. Bid-Ask Trading Spread N/A 140 - e HSMBI ——CCB (939.HK)
ICBC (1398.HK) BOC (3988.HK)
Liquidity Providers N/A ——ABC (1288.HK)
130 + ;
. 120 -
Transaction Cost*
Stamp Duty N/A 110 - A
Trading Fee HK$2 / contract 100 - \/—\\‘§
SFC Levy HK$0.54 / contract
90 T T
Margin as of 27 Aug 2025 HK$10,420 Jun-2025 Jul-2025 Aug-2025
Futures contracts have relatively lower transaction costs HSMBI Futures can be used for hedging

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference only

As at 29 August 2025
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CES120 Index Futures Performance

CES120 Index 5-Min Avg. Bid-Ask Spreads (29 August 2025)

80 A-Shares and 40 HK-listed Mainland
China H-shares, P-chips, and red chips

Index Description

CES120 Futures | N/A
Index Level 6,978.03 (As at 29 August 2025)

Index Volatility (30-Day Historical) | 13.6

Index Avg. Day High-Low Range 57.03 (August 2025)

CSI300 Correlation (2025) 0.862
XiShares A50 ETF (2823.HK) _ 0.10%
FTSE A50 Correlation (2025) 0.841
i 0,
CES120 Index Futures ChinaAMC CSI300 ETF (3188.HK) _ 0.09%
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.35Mn (As at 29 August 2025)

Average Quote Size HK$1.74Mn (5 Contracts) CES120 & Top Constituents’ 3-Month Performance
Rebased to 100

Average Bid-Ask Trading Spread| N/A

140 1= CES120 Index Tencent CCB
Liquidity Providers N/A Ping An —— China Mobile
130 -
Transaction Cost* 120 - /\,/\—
Trading Fee HK$5 / contract
100 -
SFC Levy HK$0.54 / contract
: 90 . .
Margin as of 27 Aug 2025 HK$16,960 Jun-2025 Jul-2025 Aug-2025
Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference only

As at 29 August 2025
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Flagship Futures - Contract Specifications

Hang Seng China Enterprises Index

Hang Seng Index Futures Hang Seng TECH Index Futures

Futures

Underlying Index
HKATS Code
Contract Multiplier
Minimum
Fluctuation

Contract Months

Pre-Market
Opening Period

Trading Hours

Last Trading Day

Final Settlement
Price

Exchange Fee

Data Source: HKEX

X

Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
HSI HHI HTI

HK$50 per index point

One index point

Short-dated Futures: Spot, next three

Short-dated Futures: Spot, next three calendar month & next three calendar quarter calendar month & next three calendar
months; quarter months;
Long-dated Futures: The three months of Jun and Dec plus the next three months of Dec Long-dated Futures: The three months of
Jun and Dec

8:45 am - 9:15am & 12:30 pm - 1:00 pm

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am
(Closed at 4:00 pm on the Last Trading Day)

The second last trading day of the contract month
Average quotations of the underlying index taken at five minute intervals during the Last Trading Day

HK$10.00 HK$3.5 HK$5.00

16



Flagship Options - Contract Specifications

. Hang Seng China Enterprises .
“ Hang Seng Index Options Index Options Hang Seng TECH Index Options

Underlying Index Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
Monthly contracts: HSI Monthly contracts: HHI

HKATS Code Weekly contracts: “HSI” + Strike + Month +  Weekly contracts: “HHI” + Strike + HTI
Year + “W” + Expiry Day Month + Year + “W” + Expiry Day

Contract Multiplier HK$50 per index point

Minimum Fluctuation One index point

Monthly contracts
Short-dated Options: Spot, next three calendar months & next three calendar
quarter months;
Long-dated Options: the next 3 months of Jun & Dec
and the following 3 Dec months

Monthly contracts
Short-dated Options: Spot, next three
calendar months & next three
calendar quarter months;
Long-dated Options: the next 3 months of

Contract Months /
Contract Weeks

Weekly contracts

Spot Week and the next week, except where the Expiry Day of the Weekly Contract Jun & Dec
is the same as the Expiry Day of the Spot Month Contract
Exercise Style European Style
Option Premium Quoted in whole index points
Short-dated Options (monthly and weekly contracts): Long-dated Options (monthly contracts only):
Strike Price = 20,000 200 = 20,000 400
= 5,000 and < 20,000 100 = 5,000 and < 20,000 200
< 5,000 50 < 5,000 100
Trading Hours 9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am (Closed at 4:00 pm on the Expiry Day)
Expiry Day The second last trading day of the contract month (monthly contracts)

The last trading day of the contract week (weekly contracts)

Official Settlement
Price

Exchange Fee HK$10.00 HK$3.50 HK$5.00

Average of quotations of the Index taken at five minute intervals during the Expiry Day

Data Source: HKEX

X .



Flagship Futures Options - Contract Specifications

Hang Seng Index Futures Hang Seng China Enterprises Hang Seng TECH Index Futures
Options Index Futures Options Options

Hang Seng China Enterprises Index

Underlying Index Hang Seng Index Futures Hang Seng TECH Index Futures

Futures
HKATS Code PHS PHH PTE
Contract Multiplier HK$50 per index point
Min. Fluctuation One index point
Short-dated Options: Spot, next three
Short-dated Options: Spot, next three calendar months & next three calendar months & next three calendar
Contract Months calendar quarter months and quarter months and
Long-dated Options: the next 3 months of June & December and the Long-dated Options: the next 3 months
following 3 December months of June & December after Short-dated
Options
Exercise Style European Style
Option Premium Quoted in whole index points
Index points | Strike interval Index points Strike interval
Short-dated Options: Long-dated Options:
Strike Price > 20,000 200 > 20,000 400
25,000 and < 20,000 100 2 5,000 and < 20,000 200
< 5,000 50 < 5,000 100

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am
(Closed at 4:00 pm on the Expiry Day)

Expiry Day The third Friday of the contract month

Trading Hours

Settlement on Physical delivery on Exercise. All in-the-money options are automatically exercised upon expiry

Exercise

Official Settlement Average of quotations of the Index Futures Contract of the same contract month,

Price taken at five second intervals from 3:55 p.m. — 4:00 p.m. on the Expiry Day of the Index Futures Options
Exchange Fee HK$10.00 HK$3.5 HK$5.0

Data Source: HKEX

X



Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTI/<yy><m>.HF HTI/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DZH HTI

East Money HTI

Information

ESunny Information ~ HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X
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MSCI Asia and Emerging Market Index Futures Access Codes

MSCI
Information (USD) Index
Vendor Futures
Bloomberg HKCA Index
Refinitiv 0#HMAN:
WIND MANF.HK

MSCI EM ex
Korea NTR
Information |(USD) Index
Vendor Futures
Bloomberg HQIA Index
Refinitiv O#HMXK:
WIND

MSCI Japan
Information |NTR (JPY)
Vendor Index Futures
Bloomberg HQBA Index
Refinitiv O#HMJJ:
WIND

Information |(USD) Index

Vendor Futures
Bloomberg HOBA Index
Refinitiv 0#HMGN:
WIND

Data Source: HKEX

X

MSCI EM Asia |MSCI EM Asia
MSCI China ex Korea NTR
Connect (USD) (USD) Index (USD) Index
Index Futures Futures Futures
MCYA Index CSIA Index CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index
0#HMCA: O#HCHI: O#HCHN: 0#HMAC: O0#HMAK: O#HEAN: O#HMEE: O#HMXC:
MCAF.HK EANF.HK

MSCI EM
LatAm NTR
(USD) Index
Futures

HQYA Index
O#HMEL:

MSCI Japan
NTR (USD)
Index Futures

HJCA Index
O0#HMJU:
MJUF.HK

MSCI

Singapore
NTR (USD)
Index Futures

HKPA Index
O0#HMSN:

HMPA Index
O0#HMEM:

MSCI Malaysia
(USD) Index
Futures

HMYA Index
O#HMMY:

MSCI Taiwan
(USD) Index
Futures

HJAA Index
O#HMTW:
MTWF.HK

HMOA Index
O#HEMN:

HLCA Index
O0#HMHN:

MSCI New
MSCI Malaysia [Zealand NTR
NTR (USD) (USD) Index
Index Futures |Futures
HKEA Index HOPA Index
O0#HMMN: O#HMNZ:
MMNF.HK

MSCI Taiwan
MSCI Taiwan |25/50 NTR
25/50 (USD) (USD) Index
Index Futures |Futures
HRCA Index HRDA Index
O#HTWP: O#HTWN:

MSCI

MSCI India Indonesia

NTR (USD)

Index Futures
HRTA Index HJDA Index HMLA Index
0#HMDA: O#HMIN: 0#HMID:

MINF.HK
MSCI Pacific MSCI
ex Japan NTR |[MSCI Pacific [Philippines
(USD) Index |NTR (USD) (USD) Index
Futures Index Futures |Futures
HRPA Index HRBA Index = HNSA Index
O#HMPJ: 0#HMPC: 0#HMPH:

MSCI Taiwan |MSCI Thailand [MSCI Thailand
NTR (USD) (USD) Index |NTR (USD)
Index Futures |Futures Index Futures
HJBA Index HMTA Index HKDA Index
O#HMWN: O#HMTH: O#HMTN:
MWNF.HK MTNF.HK

(JPY) Index

Futures
HKBA Index HQAA Index
0#HMDN: O#HMJP:
MDNF.HK

MSCI

Singapore

Free (SGD)
Index Futures [Index Futures
HLEA Index HKOA Index
0#HMPN: 0#HMSG:

MSCI Vietham [MSCI Vietnam
(USD) Index |NTR (USD)
Futures Index Futures
HNTA Index HKSA Index
O#HMVT: 0#HMVN:
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Weekly HSI and HSCEI Options Access Codes

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O0#HSIW*.HF> <0#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJmy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF

Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks Mainland Banks
Index Index Futures

AASTOCKS 221420
Activ Financial =0200700.HK MBI/16K.HF
AFE 837451 870809
Bloomberg HSMBI Index BMWA Index
DB Power MBI

ET Net MBN MBI
Infocast HSMBI MBI
QuotePower SEHK.HHSMBI P11223
Telequote MBImy
Refinitiv .HSMBI O0#HMBI:

Mainland Information Vendors

Information Vendor Mainland Mainland Banks
Banks Index Index Futures

East Money HSMBI MBI
Hexin Flush Financial MBIC
Pobo Financial MBI+Month+Year
Qianlong 999905 209
Wind HSMBI MBIF+yymm+HK

Data Source: HKEX

X
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 0#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Etr:jeng Zhou Esunny Information Technology Co, _ CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X
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